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2SISCOM > INTRODUCTION

SISCOM (Subtraction Ictal SPECT CO-registered to MRI) is a research application which allows ictal and interictal SPECT images to be 

combined with MRI images. This application allows fusion of the functional information from the SPECT scans with the structural detail of 

the MRI, an important synergistic visualization which allows direct functional to structural correlation and analysis. SISCOM has been a part 

of the Analyze visualization and analysis software package since 1996 and is used by researchers around the world. The implementation of 

SISCOM in Analyze 15.0 allows for a more intuitive workflow involving the following steps:

•	 Determine thresholds for both the ictal and interictal SPECT images to segment cortical voxels for registration and analysis.

•	 Register the ictal and interictal SPECT volume images.

•	 Segment the brain from the ictal and co-registered interictal images and create a combined mask for the cortical structure.

•	 Normalize and subtract the ictal and interictal SPECT images.

•	 Determine the statistical regions of hyperperfusion and hypoperfusion from the subtraction SPECT image.

•	 Segment the cortical anatomy from the 3D T1-weighted MRI.

•	 Register the SPECT volume images to the MRI volume.

•	 Apply the SPECT/MRI registration transform to the hyper- and hypoperfusion maps.

•	 Fuse the functional maps with the MRI to directly correlate function to structure.

•	 Review the 3D SISCOM volume image to examine areas of relevance in both hyperperfusion and hypoperfusion.

•	 Generate a new full color, secondary capture DICOM volume for the 3D SISCOM volume image.

The majority of these steps are automated and require minimal user intervention.

Introduction
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SISCOM requires three data sets: an ictal SPECT image, an interictal SPECT image and an MRI image of the same region. Examples of such 

scans can be downloaded from https://analyzedirect.com/data. These example image files include:

•	 SISCOM_Ictal_SPECT: An ictal SPECT volume image. The volume is 64 x 64 x 45, acquired coronally, and has an isotropic voxel 

resolution of 4.1 x 4.1 x 4.1 mm3. A colormap is associated with this volume image.

•	 SISCOM_Interictal_SPECT: An interictal SPECT volume image. This volume is 64 x 64 x 45, acquired coronally, and has an isotropic 

voxel resolution of 4.1 x 4.1 x 4.1 mm3. A colormap is also associated with this volume image.

•	 SISCOM_MRI: An isotropic MRI volume image. This volume is 256 x 256 x 231, acquired coronally, and has an isotropic voxel 

resolution of 0.859 x 0.859 x 0.859 mm3.

For the remainder of this guide, we will refer to these data sets. To follow along, download the files from https://analyzedirect.com/data/ and 

load into the Analyze workspace using the Input/Output module.

Required SISCOM Image Data

Accessing SISCOM

SISCOM is accessed from the Analyze Apps area in the lower right-hand 

corner of the main Analyze window. If SISCOM does not show in the 

Apps area it can be enabled by right-clicking in the module selection 

area and then selecting the Apps > Show All menu option.

Please note that SISCOM is accessible to all Analyze users and requires a 

modification to the Analyze license to run. If your Analyze license has not 

yet been modified for SISCOM access, a validation error will be returned. 

Please follow the instruction on the message or contact support@

analyzedirect.com for more information about accessing SISCOM.
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As mentioned, SISCOM requires three 

input volumes; An ictal SPECT, an 

interictal SPECT, and an MRI. This is 

also the order in which the data must 

be loaded into SISCOM, as when the 

module is opened, the first selection 

is expected to be the ictal SPECT 

volume input, the second selection 

the interictal SPECT volume input, 

and the third the MRI volume image 

input.

In the Analyze workspace, select the 

Ictal SPECT volume image with the 

left mouse button. Then select the 

Interictal SPECT volume image using 

the middle mouse button (or Shift 

> left mouse button if no middle 

button is available). Then select the 

MRI volume image using the middle 

mouse button, this will result in all 

three of the input volume images 

being selected. Having selected the 

images in the correct order, click on 

the SISCOM icon to open SISCOM.

Loading Data into SISCOM
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The SISCOM module interface provides access to all functions and tools required to process image data for SISCOM analysis, including: 

1) Menu, 2) Display tools, and 3) SISCOM processing tabs and tools.

Each of these functional areas will be described in the following pages.

SISCOM Module Interface
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The SISCOM menu provides access to the File, Other, and Help menus.

File

The File menu allows users to access the Input/Output ports and Exit function.

Input/Output ports: Displays a Volume area at the bottom of the SISCOM module window. This area facilitates the dragging and dropping 

of image data into the module. The area also displays the volumes created during the SISCOM process. Right clicking on any of the input 

ports in the Input/Output Ports provide several additional options for unloading data and exporting volumes and registration matrix files. 

These are now described:

•	 Ictal: Right clicking on the Ictal port provides the following options:

	· Unload Ictal: Unloads the current ictal input volume. 

	· Export Registered Ictal: Saves the registered ictal data set to the workspace. 

	· Export Matrix: Allows users to save the following registration transformation matrix files. 

		  Ictal > Interictal: Save the Ictal to Interictal matrix file.  

		  Interictal > Ictal: Save the Interictal to Ictal matrix file.

•	 Interictal: Right clicking on the Interictal port provides the following options:

	· Unload Interictal: Unloads the current interictal input volume. 

	· Export Registered Interictal: Saves the registered interictal data set to the workspace. 

	· Export Matrix: Allows users to save the following registration transformation matrix files. 

		  Interictal > Ictal: Save the Interictal to Ictal matrix file.  

		  Interictal > MRI: Save the Interictal to MRI matrix file.

Menu
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File > Input/Output ports (continued):

•	 MRI: Right clicking on the MRI port provides the following options:

	· Unload MRI: Unloads the current MRI input volume. 

	· Export Matrix: Allows users to save the following registration transformation matrix files. Note that these are only available for output 

once the Register SPECT/MRI step is complete. 

		  MRI > Ictal: Save the MRI to Ictal matrix file.  

		  MRI > Interictal: Save the MRI to Iinterictal matrix file.

•	 Hyper: Right clicking on the Hyper port provide the following options:

	· Export Hyper Map: Saves a copy of the hyperperfusion map in the space of the Ictal input to the workspace.

	· Export Thresholded Hyper Map: Saves a copy of the hyperperfusion map, thresholded based on hyper Z-Score, in the space of the 

Ictal input to the workspace.

	· Export Restricted Hyper Map: This export option is only available if the Restrict Hyper option is enabled. Saves a copy of the 

hyperperfusion map, thresholded based on hyper Z-Score and restricted using the Restrict Hyper parameter, in the space of the Ictal 

input to the workspace.

	· Export Registered Hyper Map: Saves a copy of the hyperperfusion map in the space of the MRI input to the workspace. Note this 

option is only available for output once the Register SPECT/MRI step is complete.

	· Export Registered Thresholded Hyper Map: Saves a copy of the hyperperfusion map, thresholded based on hyper Z-Score, 

in the space of the MRI input to the workspace. Note this option is only available for output once the Register SPECT/MRI step is 

complete.

	· Export Registered Restricted Hyper Map: This export option is only available if the Restrict Hyper option is enabled. Saves a copy 

of the hyperperfusion map, thresholded based on hyper Z-Score and restricted using the Restrict Hyper parameter, in the space of the 

MRI input to the workspace. Note this option is only available for output once the Register SPECT/MRI step is complete.

Menu (continued)
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File > Input/Output ports (continued):

•	 Hypo: Right clicking on the Hypo port provide the following options:

	· Export Hypo Map: Saves a copy of the Hypoperfusion map in the space of the Ictal input to the workspace.

	· Export Thresholded Hypo Map: Saves a copy of the Hypoperfusion map, thresholded based on Hypo Z-Score, in the space of the 

Ictal input to the workspace.

	· Export Restricted Hypo Map: This export option is only available if the Restrict Hypo option is enabled. Saves a copy of the 

Hypoperfusion map, thresholded based on Hypo Z-Score and restricted using the Restrict Hypo parameter, in the space of the Ictal 

input to the workspace.

	· Export Registered Hypo Map: Saves a copy of the Hypoperfusion map in the space of the MRI input to the workspace. Note this 

option is only available for output once the Register SPECT/MRI step is complete.

	· Export Registered Thresholded Hypo Map: Saves a copy of the Hypoperfusion map, thresholded based on Hypo Z-Score, in 

the space of the MRI input to the workspace. Note this option is only available for output once the Register SPECT/MRI step is 

complete.

	· Export Registered Restricted Hypo Map: This export option is only available if the Restrict Hypo option is enabled. Saves a copy 

of the Hypoperfusion map, thresholded based on Hypo Z-Score and restricted using the Restrict Hypo parameter, in the space of the 

MRI input to the workspace. Note this option is only available for output once the Register SPECT/MRI step is complete.

•	 Extracted Brain: Right clicking on the Extracted Brain port provide the following option:

	· Export Extracted Brain: Saves a copy of the greyscale segmented brain from the MRI input to the workspace. Note that this option 

is only available once the MRI brain segmentation step has been completed.

Exit: Closes SISCOM.

Menu (continued)
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Other

The Other menu provide users with access to the Options menu and Powerbar Editor. 

Options: When selected opens the Options menu providing access to Module configuration options, including:

•	 Auto Note Update: Allows the Auto Note Update option to be enabled or disabled.

•	 Threads: Allows users to specify the number of threads used in a multi-threaded rendering process. By default, the number of threads is 

set to the number of processors on the system. 

Powerbar Editor: When selected opens the PowerBar editor allowing users to add additional shortcut buttons to the tools area of the 

Segment window.

Help

The Help menu provides users with quick access to help resources including:

About: View version, system and environment information.

User’s Guide: Opens a link to the Analyze 15.0 SISCOM User’s Guide.

Menu (continued)
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The Display Tools options provide access to the Toggle Cursor Link, Input/Output Ports and the Set Note State tools.

Cursor Link

The cursor link allows users to interactively navigate through the image data. The tool can be controlled from any of the 2D orientations or 

from the 3D rendering on the review tab. Moving the cursor will interactively update the corresponding slice displays.

The linked cursor can be enabled or disabled using the Toggle Cursor Link button.

Display Tools
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Input/Output Ports

The Input/Output ports tool displays a Volume area at the bottom of the SISCOM module window. This area facilitates the dragging and 

dropping of image data into the module. The area also displays the volumes created during the SISCOM process. See the description of 

Input/Output ports under File above for a full description of the options available.

Notes

The set note state button allows users to enable the Notes tool. The Notes tool allows users to annotate the 2D slice data or 3D rendering. 

Notes are automatically associated with the data set and can be displayed in other modules. Notes can be hidden or deleted at any time. 

To annotate a data set using notes click on the Notes button in the toolbar. (Note that the Edit mode will be activated.) Click on any 2D slice 

or the 3D rendering to create a note.

The SISCOM workflow is divided into three processing tabs;

•	 SPECT Processing

•	 MRI Processing

•	 Review 

Each of these processing tabs, and the tools contained therein, are now described.

Display Tools (continued)

SISCOM Processing Tabs and Tools
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The SPECT Processing step in the SISCOM workflow accomplishes several important tasks:

•	 Determine thresholds for ictal/interictal SPECT images to segment cortical voxels for registration and analysis.

•	 Register the ictal and interictal SPECT volume images.

•	 Segment the brain from the ictal and coregistered interictal volumes images and create a combined mask for the brain.

•	 Normalize and subtract the ictal/interictal SPECT images.

•	 Determine the statistical regions of hyperperfusion and hypoperfusion from the subtraction SPECT image.

These tasks are done automatically when the SPECT Processing workflow panel is invoked. The registration, segmentation and functional 

map computation often need no user intervention. The user can establish appropriate statistical cutoffs for the hyperperfusion and 

hypoperfusion maps based on the signal strength and desired functional representation. The main components of the SPECT Processing 

workflow panel are shown in the next image and described below. Note: The linked cursor, shown in all image panels, can be used to move 

through the registered volume images. Each image window also has zoom and window/level controls for enhanced viewing of the images.

The SPECT Parameter Controls (left menu): This contains all of the controls for the tasks in this process. Each will be described below. [1]

Ictal (red column): The left column of images (red column) contains the ictal SPECT volume image shown as transverse, coronal and sagittal 

images. This is the base image set to which the interictal volume is registered. The current cerebral activity threshold is shown as a red 

boundary. [2]

Interictal (green column): The next column of images (green column) contains the registered interictal SPECT volume image. Note that 

these images have already been transformed by the registration transform that is automatically determined when the SPECT Processing 

panel is invoked. [3]

SPECT Processing
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Registered (yellow column): The fused representation of the registered ictal and interictal SPECT volume images is shown with red/green 

color blending for direct evaluation of the registration results. The type of fusion can be controlled by the Interictal To Ictal Registration 

Display selection. [4]

Hyper/Hypo Maps (blue column): The right column shows the hyper- and hypoperfusion maps fused with one of the SPECT input volumes 

(ictal by default). The amount of functional signal depicted in the map is controlled by the statistical cutoffs. [5]

SPECT Processing (continued)
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Thresholds are established for each SPECT input to select signal specific to voxels within the cortex. By default, the exterior boundary of the 

threshold region is shown as a red overlay on the SPECT images. These two masks are combined into a single mask of cortical activity, which 

is applied to the functional maps to limit the activity to within the bounds of the cortex. The thresholds should be optimized to eliminate any 

background activity, with the boundary on the outer edge of signal from the cortex.

Cerebral Activity Thresholds / SPECT Mask Display

Ictal Cerebral Activity Threshold: this double-ended slider 

establishes the range of signal values for cortical signal in the ictal 

SPECT volume image. All signal between and including the Min and 

Max values will be part of the ictal mask. The Colormap check box 

will turn on/off the colored representation of the SPECT signal.

Interictal Cerebral Activity Threshold: this double-ended slider 

establishes the range of signal values for cortical signal in the ictal 

SPECT volume image. All signal between and including the Min and 

Max values will be part of the ictal mask. The Colormap check box 

will turn on/off the colored representation of the SPECT signal.

SPECT Mask Display: the Opacity slider controls the opacity of 

the red overlay used to depict the cortical signal threshold mask on 

the SPECT image: 0% = no overlay, 100%=full intensity overlay. The 

Edges Only check box changes the display of the mask between just 

the boundaries (checked) or the entire set of voxels in the threshold 

range (unchecked).
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The registration of the interictal volume image to the ictal volume image is accomplished automatically using a normalized mutual 

information registration algorithm, making it very robust to localized differences in signal value, orientation and threshold determination. By 

default, this registration is carried out automatically when the SPECT Processing panel is invoked. Upon visual evaluation of the registration 

results as depicted in the Registered (yellow) column, if the registration is incorrect, the transformation between the interictal and ictal 

volumes images can be manually adjusted.

Interictal to Ictal Registration

Display: controls the type of visual fusion between the ictal and registered interictal 

images as shown in the Registered (yellow) column. The fusion options are as follows:

•	 Grayscale Red-Green: (Default) Ictal colored red and registered interictal colored green, with intensity of color modulated by SPECT 

signal. Overlapping signal with common intensity will be yellow. 

•	 Grayscale Yellow-Cyan: Ictal colored yellow and registered interictal colored cyan, with intensity of color modulated by SPECT signal. 

Overlapping signal with common intensity will be white.

•	 Binary Red-Green: Ictal colored red and registered interictal colored green, with only those voxels within the current SPECT thresholds 

shown as a single binary intensity. Overlapping voxels will be yellow.

•	 Binary Yellow-Cyan: Ictal colored red and registered interictal colored green, with only those voxels within the current SPECT 

thresholds shown as a single binary intensity. Overlapping voxels will be white.

•	 Difference: The registered interictal will be subtracted from the ictal and the difference shown as a grayscale image. Zero-valued 

differences will be a mid-gray intensity.

Register: this button will invoke the registration process starting from the current registration transformation between the interictal and 

ictal volumes.
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Manual Reg: when checked, the manual registration control panel will be displayed 

below the check box enabling manual manipulation of the interictal volume in register 

with the ictal volume. When unchecked, a registration will be done automatically 

when the SPECT Processing panel is first invoked and whenever one of the controls is 

changed, such as the SPECT thresholds.

The Manual Registration Controls allow manual application of rotation and 

translation in all six degrees of freedom to transform the interictal volume into 

registration with the ictal volume. options are as follows:

•	 Orientation: The orientation buttons at the top of the panel choose which 

orientation a limited set of two translation degrees of freedom and one rotational 

degree of freedom can be applied: axial allowing translation along X and Y, 

rotation about Z; coronal allowing translation in X and Z, rotation about Y; and 

sagittal allowing translation in Y and Z, rotation about X.

•	 Rotation and Translation: The translation and rotation buttons apply an incremental change in these transformations, with the size of 

the increment controlled by the options on the bottom 

•	 Increment: Course=10 voxels/10 degrees, Medium=5 voxels/5 degrees, Fine=1 voxel, 1 degree. An optional entry field is provided on 

the right to set a user-established increment for manual manipulation.

Reset: resets the interictal to ictal registration transform to the identity transform (no registration).

Interictal to Ictal Registration (continued)
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Functional Map Settings – Maps

The Map controls and Map Settings establish the content and statistical significance 

reflected in the SISCOM hyperperfusion and hypoperfusion maps, as shown in the 

Hyper/Hypo Maps (blue) column.

Functional Map Settings

Hyper/Hypo/Both: selects which functional maps are depicted in the fused images 

shown in the Hyper/Hypo Maps (blue) column. Choose from:

•	 Hyper: only shows regions of hyperperfusion. 

•	 Hypo: only shows regions of hypoperfusion. 

•	 Both: (Default) displays both the hyperperfusion and hypoperfusion maps.

Background: controls the image upon which the hyper/hypo functional maps are 

displayed in the fused representation. The following options are available:

•	 Ictal: (default) Displays the ictal SPECT volume image as a grayscale image. 

•	 Interictal: Displays the registered interictal SPECT volume image as a grayscale 

image.

•	 None: Turns off the display of the SPECT images, showing only the functional 

SISCOM map.

Map Blend Percent: The Map Blend Percent slider allows users to adjust the blend 

percent of the background ictal or interictal image with the hyper and/or hypo 

functional maps.
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Functional Map Settings (continued)

Show Z-Scores: The show Z-Score checkbox allows users to enable 

or disable the display of the hyper and hypo region z-scores. When a 

hyper or hypo region is selected the z-score is displayed in the upper 

right-hand corner of the Hyper/Hypo Maps display area. Z-Score 

are color coded, orange for hyper and blue for hypo, to prevent 

confusion.

Functional Map Settings – Z-Score Threshold

Z-Score Threshold (Std. Dev): The Z-Score Threshold options provide users with the ability to adjust the parameters used for the 

generation of the Hyper and Hypo maps. The following options are available: 

•	 Hyper: The Hyper slider sets the level of statistical significance shown in the functional SISCOM map for regions of activation 

(hyperperfusion). The numeric value unit is in standard deviations of the variance in the SISCOM subtraction image, which is shown in the 

Standard Deviation = field. By default, this is set to 2.0 standard deviations, with a selectable range from 0.1 to 5.0 standard deviations.

•	 Restrict Hyper to # Regions: The Restrict Hyper to # Regions check box and numeric value allows further control for the display of the 

hyperperfusion regions to only the # largest regions of activation, as determined by the number of 3D connected voxels in a specific 

region.

•	 Hypo: The Hypo slider sets the level of statistical significance shown in the functional SISCOM map for regions of decreased perfusion 

(hypoperfusion). The numeric value unit is in standard deviations of the variance in the SISCOM subtraction image, which is shown in the 

Standard Deviation = field. By default, this is set to 2.0 standard deviations, with a selectable range from 0.1 to 5.0 standard deviations.

•	 Restrict Hype to # Regions: The Restrict Hypo to # Regions check box and numeric value allows further control for the display of the 

hypoperfusion regions to only the # largest regions of hypoperfusion, determined by the number of 3D connected voxels in a specific 

region.
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The MRI Processing step in the SISCOM workflow accomplishes several important tasks:

•	 Segment the cortical anatomy from the 3D T1-weighted MRI.

•	 Register the SPECT volume images to the MRI volume.

•	 Apply the SPECT/MRI registration transform to the hyper- and hypoperfusion maps.

•	 Fuse the functional maps with the MRI to directly correlate function to structure.

The main components of the MRI Processing workflow panel are as follows (numbers refer to image on the next page):

Tool Control Panel: This column [1] contains all the controls for the tasks in this process. Each will be described later in this section.

MRI (pink column): The left column of images (pink column) contains the unsegmented MRI volume image shown as transverse, coronal 

and sagittal images. This is the base volumetric MRI image set to which the SPECT volumes are registered. The green overlay on the images 

depicts the current threshold setting for the segmentation task, as controlled by the Threshold slider. The red boundary shown on the image 

corresponds to the current segmentation target [2].

Segmented MRI (red column): The next column of images (red column) contains the segmented MRI volume image. Note that these 

images will not be present until the Extract Brain button is selected to do the cortical structure segmentation [3].

SPECT/MRI (yellow column): The fused representation of the registered SPECT and MRI volume images is shown with red/green color 

blending for direct evaluation of the registration results. Note that the registration results will not be shown until the Register action has 

been completed [4].

Maps/MRI (blue column): The right column shows the hyper- and hypoperfusion maps fused with the MRI volume image. The amount of 

functional signal depicted in the map is controlled by the statistical significance map settings [5].

MRI Processing
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The linked cursor shown in all of the image panels can be used to move through the registered volume images. Each image window also has 

zoom and window/level controls for enhanced viewing of the images.

MRI Processing (continued)
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The segmentation of the cortical structure from the 3D T1-weighted MRI volume image is accomplished with an automated morphological 

segmentation algorithm that requires the definition of the target anatomy to be segmented. To do this, a seed point must be selected in 

the cortical region and thresholds established to provide a bounded representation of the cortex in one of the orthogonal images displayed 

in the first column. The seed point from which the bounded cortical region is grown is shown as a diamond-shaped yellow marker, initially 

displayed on the transverse image. This seed point can be placed using the left mouse button on any of the images in the left column, 

with image selection done by the user to provide an optimal image in which to define the bounded cortical region (as shown in the MRI 

Processing Panel image, a coronal section has been chosen). Once the optimal image has been chosen and seed point selected, the 

controls for defining this target region and doing the cortical segmentation are as follows:

Brain MRI Segmentation

MRI Threshold: this double-ended slider establishes the range of signal values for 

cortical signal in the MRI volume image. All signal between and including the Min and 

Max values will be included in the region if spatially connected to the original seed 

point. The morphologic segmentation process is based on the ability of the process to 

break connections with anatomy exterior to the bounded red region. To optimize the 

segmentation process, the Min value should be set to determine a bound on the outer 

cortex, and to further reduce the connectivity to unwanted structures, reduce the Max value 

just to the point where voxels interior to the cortical anatomy begin to lose the green overlay 

color, then raise the value slightly to keep all cortical voxels within the threshold range.

Opacity (%): The Opacity slider controls the blending of the threshold mask overlay on the 

underlying grayscale MRI image. 

•	 Show Mask: The Show Mask check box will turn on/off the colored representation of the 

voxels currently within the Threshold range.

•	 Color: The color of the mask can also be controlled by the colored button next to the 

Show Mask check box.
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Extract Brain: this button will invoke the automated 

morphologic segmentation process with the current 

Threshold settings and the current target region. 

The result of the segmentation will be shown in the 

Segmented MRI (red) column.

Auto Extract: if this check box is enabled, the 

morphologic segmentation process will automatically be 

invoked when the MRI Processing tab is selected in the 

workflow. If a seed point and threshold had previously 

been defined for a specific MRI volume image, 

enabling Auto Extract will allow the segmentation to 

be done without additional user manipulation of the 

segmentation parameters. If enabled and the Threshold 

values are changed, the segmentation process will again 

be invoked automatically with the new segmentation 

settings.

Brain MRI Segmentation (continued)
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The registration of the SPECT volume image to the MRI volume image is accomplished 

automatically using a surface-based registration algorithm. This registration is carried out following 

the segmentation of the cortical structure from the MRI volume image. Upon visual evaluation 

of the registration results as depicted in the SPECT/MRI (yellow) column, if the registration is 

incorrect, the transformation between the SPECT and MRI volumes images can be manually 

adjusted.

Register: this button will invoke the registration process starting from the current registration 

transformation between the SPECT and MRI volumes.

SPECT to MRI Registration

Manual Reg: when checked, the manual registration control panel will be displayed below the check box enabling manual manipulation 

of the SPECT volume in register with the MRI volume. When unchecked, a registration will be competed automatically when the MRI 

Processing panel is first invoked and whenever one of the controls is changed, such as the MRI segmentation.

The Manual Registration Controls allow manual application of rotation and translation in all six degrees of freedom to transform the ictal 

volume into registration with the MRI volume. 

•	 Orientation: The orientation buttons at the top of the panel choose which orientation a limited set of two translation degrees of 

freedom and one rotational degree of freedom can be applied: axial allowing translation along X and Y, rotation about Z; coronal 

allowing translation in X and Z, rotation about Y; and sagittal allowing translation in Y and Z, rotation about X. 

•	 Rotation and Translation: The translation and rotation buttons apply an incremental change in these transformations, with the size of 

the increment controlled by the options on the bottom.

•	 Increment: Course=10 voxels/10 degrees, Medium=5 voxels/5 degrees, Fine=1 voxel, 1 degree. An optional entry field is provided on 

the right to set a user-established increment for manual manipulation.

Reset: resets the interictal to ictal registration transform to the identity transform (no registration).
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The result of the registration of the SPECT volume image to the MRI volume image is 

depicted in the SPECT/MRI (yellow) column. This registration should be carefully evaluated 

to ensure the function to structure correlation is correct prior to further processing with the 

fused SISCOM volume image. The following controls can be used to optimize the display of 

the functional SPECT image on the grayscale MRI volume image:

Ictal: selects the registered ictal SPECT volume image to be displayed fused with the MRI 

volume image.

Interictal: selects the registered interictal SPECT volume image to be displayed fused with 

the MRI volume image.

Colormap: this check box will enable/disable the display of the SPECT volume images with 

the standard ‘hot-body’ colormap.

Fuse Blend Percent: this slider controls the blending of the SPECT volume image and the 

MRI volume image, with 0% being only the MRI volume, 100% showing only the SPECT 

volume.

SPECT/MRI Display
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The Maps/MRI controls and Map Settings establish the content and statistical significance 

reflected in the SISCOM hyperperfusion and hypoperfusion maps, as shown in the Maps/

MRI (blue) column.

Hyper / Hypo / Both: selects which functional map is depicted in the fused images shown 

in the Maps/MRI (blue) column. Choose from: 

•	 Hyper: only shows regions of hyperperfusion. 

•	 Hypo: only shows regions of hypoperfusion. 

•	 Both: (Default) displays both the hyperperfusion and hypoperfusion maps.

Show Z-Score: Turns on/off the display of the statistical significance value (z-score) at 

the location of the linked cursor on the images in the Maps/MRI (blue) column. When 

checked (default), the z-score of the voxel identified by the 3D position of the linked cursor 

will be shown in the upper left of the image display window in which the cursor is being 

manipulated. This allows direct interrogation of the significance of any areas of activation 

(hyperperfusion) or decrease in function (hypoperfusion). Z-score values are color coded, 

orange for hyper and blue for hypo, to prevent confusion. When the Show Z-Score option is 

unchecked, the statistical significance readout is not shown.

Functional Map Settings - Maps/MRI
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Z-Score Threshold (Std. Dev): The Z-Score Threshold options provide users with the ability to adjust the parameters used for the 

generation of the Hyper and Hypo maps. The following options are available: 

•	 Hyper: The Hyper slider sets the level of statistical significance shown in the functional SISCOM map for regions of activation 

(hyperperfusion). The numeric value unit is in standard deviations of the variance in the SISCOM subtraction image, which is shown in the 

Standard Deviation = field. By default, this is set to 2.0 standard deviations, with a selectable range from 0.1 standard deviations up to 

5.0 standard deviations.

•	 Restrict Hyper to # Regions: The Restrict Hyper to # Regions check box and numeric value allows further control for the display of the 

hyperperfusion regions to only the # largest regions of activation, as determined by the number of 3D connected voxels in a specific 

region.

•	 Hypo: The Hypo slider sets the level of statistical significance shown in the functional SISCOM map for regions of decreased perfusion 

(hypoperfusion). The numeric value unit is in standard deviations of the variance in the SISCOM subtraction image, which is shown in the 

Standard Deviation = field. By default, this is set to 2.0 standard deviations, with a selectable range from 0.1 standard deviations up to 

5.0 standard deviations.

•	 Restrict Hypo to # Regions: The Restrict Hypo to # Regions check box and numeric value allows further control for the display of the 

hypoperfusion regions to only the # largest regions of hypoperfusion, as determined by the number of 3D connected voxels in a specific 

region.

Functional Map Settings - Z-Score Threshold



Analyze 15.0 User’s Guide	 © AnalyzeDirect, Inc.

27SISCOM > REVIEW

The Review tab allows users to review the SISCOM images generated in the 

SPECT processing and MRI processing tabs. SISCOM image data can be reviewed 

using in 3D mode (Four Panel Display) or in 2D mode (Multi Panel Display). 

Display

There are two display modes for image review Multi Panel Display [1] mode and 

Four Panel Display [2] mode. Both modes are described in detail later in this 

section. 

Overlay

The overlay drop-down menu allows users to select which functional map will be 

displayed with the MRI data set in both Multi Panel Display mode or Four Panel 

Display mode. Users can choose from: 

Ictal SPECT: Overlays the registered ictal SPECT image onto the MRI.

Interictal SPECT: Overlays the registered interictal SPECT image onto the MRI.

Review
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Hyper Map: Overlays the registered hyperperfusion map onto the MRI.

Hypo Map: Overlays the registered hypoperfusion map onto the MRI.

Both Maps: (Default) Overlays both the registered hyperperfusion and 

hypoperfusion maps onto the MRI.

Review (continued)
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When Multi Panel Display mode is enabled image data will be displayed as a panel of sections from a single orthogonal orientation [3]. 

Multi Panel Display
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The following options are available:

Orientation

Orient: The Orient tool allows users to switch to switch between any of the three orthogonal 

orientations; Axial, Coronal, or Sagittal. Left click on the Orient tool to cycle through the orthogonal 

displays or right-click and choose the desired display option from the menu.

Slice

Start Slice: The Start Slice slider allows users to specify the starting slice in the selected orientation 

for 2D image display. Use the slider to adjust the starting slice or enter the desired value in the slice 

field.

Increment: The Increment tool allows users to specify the interval used to determine the next image 

to be displayed. Click the yellow Increment text, the cursor will update to display an up/down INCR 

cursor. Hold down the left mouse button and slide the cursor upward to increase the increment value 

and downward to decrease the increment value.

Layout

The number of panels shown can be controlled using the Columns/Rows button. Use the Page Down 

and Page Up buttons to change the slices shown.

Blend

Map Blend Percent: The Map Blend Percent slider allows users to adjust the percentage blend of the 

grayscale data and selected overlaid map option. 

Multi Panel Display (continued)
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Functional Map Settings - Z-Score Thresholds

Z-Score Threshold (Std. Dev): The Z-Score Threshold options provide users with the ability to adjust the parameters used for the 

generation of the Hyper and Hypo maps. The following options are available: 

•	 Hyper: The Hyper slider sets the level of statistical significance shown in the functional SISCOM map for regions of activation 

(hyperperfusion). The numeric value unit is in standard deviations of the variance in the SISCOM subtraction image, which is shown in the 

Standard Deviation = field. By default, this is set to 2.0 standard deviations, with a selectable range from 0.1 standard deviations up to 

5.0 standard deviations.

•	 Restrict Hyper to # Regions: The Restrict Hyper to # Regions check box and numeric value allows further control for the display of the 

hyperperfusion regions to only the # largest regions of activation, as determined by the number of 3D connected voxels in a specific 

region.

•	 Hypo: The Hypo slider sets the level of statistical significance shown in the functional SISCOM map for regions of decreased perfusion 

(hypoperfusion). The numeric value unit is in standard deviations of the variance in the SISCOM subtraction image, which is shown in the 

Standard Deviation = field. By default, this is set to 2.0 standard deviations, with a selectable range from 0.1 standard deviations up to 

5.0 standard deviations.

•	 Restrict Hypo to # Regions: The Restrict Hypo to # Regions check box and numeric value allows further control for the display of the 

hypoperfusion regions to only the # largest regions of hypoperfusion, as determined by the number of 3D connected voxels in a specific 

region.

Multi Panel Display (continued)
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Regions Volumes

The Region Volumes display reports volumes of the hyperperfusion and hypoperfusion 

regions in accordance to the settings in the Z-Score Threshold section. 

Export Fused

Export Fused allows users to save the SISCOM images to the workspace. 

Multi Panel Display (continued)
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When Four Panel Display mode is enabled, a rendering of the brain [4] and the three orthogonal images [5] will be displayed.For additional 

information about the rendering and slice display windows please refer to section 2 – Image Controls and Customizations, of the Analyze 

15.0 User’s Guide.  

Four Panel Display
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The following options are available:

Render Method

The Render Method drop-down menu allows users to select which rendering method will be used for the 3-D rendering. Users can 

choose from; Brain Surface, Mapped Surface, Summer Voxel, Weighted MIP, Transparent Colored, Transparent Brain, Composite With, or 

Composite Without. 

Render Merge Percent

The Render Merge Percent slider allows users to adjust the percentage merge between the rendered map and brain. 

Blend

The Map Blend Percent slider allows users to adjust the percentage blend of the grayscale data and selected overlaid map option.

Functional Map Settings - Z-Score Thresholds

Z-Score Threshold (Std. Dev): The Z-Score Threshold options provide users with the ability to adjust the parameters used for the 

generation of the Hyper and Hypo maps. The following options are available: 

•	 Hyper: The Hyper slider sets the level of statistical significance shown in the functional SISCOM map for regions of activation 

(hyperperfusion). The numeric value unit is in standard deviations of the variance in the SISCOM subtraction image, which is shown in 

the Standard Deviation = field. By default, this is set to 2.0 standard deviations, with a selectable range from 0.1 standard deviations up 

to 5.0 standard deviations.

•	 Restrict Hyper to # Regions: The Restrict Hyper to # Regions check box and numeric value allows further control for the display of the 

hyperperfusion regions to only the # largest regions of activation, as determined by the number of 3D connected voxels in a specific 

region.

Four Panel Display (continued)
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Functional Map Settings - Z-Score Thresholds (continued):

•	 Hypo: The Hypo slider sets the level of statistical significance shown in the functional SISCOM map for regions of decreased perfusion 

(hypoperfusion). The numeric value unit is in standard deviations of the variance in the SISCOM subtraction image, which is shown in the 

Standard Deviation = field. By default, this is set to 2.0 standard deviations, with a selectable range from 0.1 standard deviations up to 

5.0 standard deviations.

•	 Restrict Hypo to # Regions: The Restrict Hypo to # Regions check box and numeric value allows further control for the display of 

the hypoperfusion regions to only the # largest regions of hypoperfusion, as determined by the number of 3D connected voxels in a 

specific region.

Regions Volumes

The Region Volumes display reports volumes of the hyperperfusion and hypoperfusion regions in accordance to the settings in the Z-Score 

Threshold section. 

Output

Export Fused allows users to save the SISCOM images to the workspace. 

Four Panel Display (continued)
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This exercise will demonstrate how to use the SISCOM module within Analyze 15.0. To start, download the following three files:

1. SISCOM_Ictal_SPECT.avw, 2. SISCOM_Interictal_SPECT.avw, and 3. SISCOM_MRI.avw

from https://analyzedirect.com/data.  Load these three files into the Analyze workspace using the Input/Output module. 

SISCOM Tutorial

Once loaded, select the data sets in the following order (hold down the shift key to select multiple data sets, or click using the middle 

mouse button): 

				    1. SISCOM_Ictal_SPECT 	 2. SISCOM_Interictal_SPECT 	 3. SISCOM_MRI

Note the selection order: 

Ictal, Interictal, MRI. If 

the data is not selected 

in this order the SISCOM 

procedure will fail to run 

correctly.

Select SISCOM from the 

Apps area. The SISCOM 

module will open to the 

SPECT processing tab.
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The SISCOM module will open to the SPECT processing tab [1]. The SPECT Processing step accomplishes several important tasks:

	· Determines thresholds for ictal/interictal SPECT images to segment cortical voxels for registration and analysis. 

	· Registers the ictal and interictal SPECT volumes. 

	· Segments the brain from the ictal and co-registered interictal volume images and creates a combined mask for the brain. 

	· Normalizes and subtracts the ictal/interictal SPECT images. 

	· Determines the statistical regions of hyperperfusion and hypoperfusion from the subtracted SPECT images.

SPECT Processing

These tasks are completed 

automatically when the 

SPECT Processing panel 

of the SISCOM workflow 

is opened. Often the 

registration, segmentation 

and functional map 

computation needs no 

user intervention, however, 

sometimes it may be 

necessary to manually 

adjust any or all steps. 

Next, we will review how to 

adjust certain parameters 

manually.
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Adjusting the Cerebral Activity Threshold for interictal SPECT images

The thresholds for cerebral activity in the ictal and interictal SPECT volumes are controlled with the sliders at the top of the left menu 

column [2]. The boundaries determined by this threshold setting are depicted by the red region borders shown on the ictal [3] and interictal 

[4] images.

Select the box on the Min end of the Interictal threshold slider and raise the threshold from 43 to 55 [5]. Note the change in the red 

boundary in the Interictal image column. When the mouse button is released, the new threshold minimum will be established and the

SPECT Processing (continued)

registration and map 

determination process 

will run using the new 

parameters.

Thresholds should be set 

to depict a reasonable 

boundary around 

cortical activity, with 

similarity between those 

boundaries between the 

ictal and interictal volume 

images.
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Modifying the SPECT Mask Display 

The SPECT Mask Display options change the way in which the thresholds are depicted on top of the ictal/interictal images. 

Uncheck the Edges Only check box [6] to see the entire set of voxels within each threshold range shown as a red overlay on the images. 

The Opacity (%) control [7] can be used to change the blending of the threshold region with the image itself.

Turn the Edges Only check box back on to show only the edges of the thresholded region.

SPECT Processing (continued)
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Optimizing registration of the SPECT data 

The interictal to ictal SPECT registration is accomplished using a mutual information algorithm, making it robust to localized differences 

in signal value, orientation and threshold determination. The registration is completed automatically, but manual manipulation of the 

registration is achieved as follows: Select the Manual Reg check box [8]. Controls for manual rotation and translation are shown in the 

registration control panel [9], allowing manual manipulation of the registration of the interictal to the ictal volume image. Select the Register 

button [10] to apply the mutual information algorithm to these unregistered, which will once again register the two SPECT volumes.

SPECT Processing (continued)

Change the Display type 

[11] to other fusion schemes 

to review the registration 

displayed in the yellow 

Registered column. [12] 

These blend options are 

used to visually establish 

the validity of the interictal/

ictal SPECT registration. It is 

important to visually verify 

this part of the SISCOM 

process to be assured of a 

valid functional map.

Reset the registration 

options by changing the 

Display type to Grayscale

Red-Green and uncheck the Manual Reg check box. Select the Register button to make sure the interictal/ictal SPECT volumes are registered.
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Reviewing the significance levels of both the Hyper- and Hypoperfusion maps 

Once the interictal and ictal SPECT images are registered, they can be normalized, subtracted and the level of significance in the functional 

signal map set to determine which voxels are considered as possible regions of hyperperfusion (increased activation) or hypoperfusion 

(decreased activation). This level of significance can be controlled by adjusting the amount of signal shown in the functional map. By default, 

the level of significance is set to 2.0 standard deviations for both the hyperperfusion map and the hypoperfusion map. To adjust the map 

settings, do the following:  

SPECT Processing (continued)

Use the linked cursor on the 

coronal image in the Hyper/

Hypo Maps (blue) [12] 

column to move the cursor 

up and to the left, to the 

area of activation shown in 

the right, superior aspect 

of the brain [13]. Note 

that the level of statistical 

significance is displayed for 

the voxel selected by the 

linked cursor [14], allowing 

exploration of the signal 

significance in a focal 

hyper- or hypoperfused 

region.
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Lower the significance setting for the hyperperfusion regions (Hyper slider in Map Settings) to a value of 1.5 standard deviations [15] and 

note the increase in the amount of activation signal in the region depicted at the location of the cursor.

Lower the significance setting for the hypoperfusion regions (Hypo slider in Map Settings) to a value of 1.5 standard deviations [16] and note 

the increase in the amount of focal deficit signal throughout the cortical structure (blue regions).

The map display can be controlled with the check buttons labeled Hyper, Hypo and Both (the default). The maps can be displayed fused 

with the Ictal SPECT volume (default), Interictal SPECT volume, or without any background SPECT image. 

Move the linked cursor throughout the 3D volume image to explore the areas of increased activation (orange regions) and areas of 

decreased perfusion (blue areas).

Vary the significance values for both the hyper- and hypoperfusion maps to see the effect of changing statistical cutoff thresholds. Mapped 

regions can also be restricted based on volume using the Restrict to # Region(s) setting [17]. Note that these regions are all displayed, at the 

original low spatial resolution of the SPECT volumes, limiting the ability to derive function-to-structure relationships in the cortical anatomy.

When satisfied with the SPECT Processing, reset the threshold values and continue to the MRI Processing step.

SPECT Processing (continued)
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The MRI Processing step 

in the SISCOM workflow 

accomplishes several 

important tasks: 

MRI Processing

The first task in the MRI Processing workflow panel is segmentation of the cortical structure from the MRI volume. This is accomplished by 

establishing a threshold range for cortical voxels and defining a bounded region around the exterior of the brain on a displayed image. To 

perform this task, do the following: 

Using the left mouse button, select a point inside the brain in the coronal image [18] in the MRI (pink) column. A diamond-shaped marker 

will denote the location of the point selected.

	· Segment the cortical 

anatomy from the 3D T1-

weighted MRI

	· Register the SPECT 

volumes to the MRI 

volume

	· Apply the SPECT/MRI 

registration transform 

to the hyper- and 

hypoperfusion maps

	· Fuse the functional maps 

with the MRI to directly 

correlate function to 

structure 
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A full 3D segmentation of 

the cortical anatomy will 

be completed using the 

MRI volume image, with 

the segmentation results 

appearing in the Segmented 

MRI (red) column [22].

MRI Processing (continued)

The current threshold range causes the red segmentation boundary to surround the entire head. Use the Threshold slider to increase the 

Minimum threshold value [19] from 16 to 21; the red boundary will now surround the surface of the cortical anatomy.

The morphologic segmentation process is based on the ability of the process to break connections with anatomy exterior to the bounded 

red region. To further reduce the connectivity to unwanted structures, reduce the Maximum value just to the point where voxels interior to 

the cortical anatomy begin to lose the green overlay color, then raise the value slightly to keep all cortical voxels within the threshold range - 

a Maximum value of 55 in this MRI volume image [20].

Select the Extract Brain [21] button to perform the brain segmentation process.
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MRI Processing (continued)

The next task in the MRI Processing workflow is to register the SPECT volumes to the MRI volume. The registration is accomplished 

automatically after segmentation of the brain is completed, registration uses the initial thresholded SPECT images (SPECT Processing panel) 

and the Segmented MRI volume. If you wish to manually adjust the registration check the Manual Registration check box to display the 

manual registration tools, select the Register once manual adjustment of the SPECT image is completed. 

Once the SPECT volumes have been registered to the MRI volume, the fused registration result is displayed in the SPECT/MRI (yellow) 

column. 

The final column displays the MRI input with the Hyper and Hypo maps overlaid. The functional maps Z-Score Threshold can be adjusted as 

described in the SPECT Processing section.

When satisfied with the MRI processing go to Review.
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Once the SISCOM volume has been generated by the SPECT Processing and MRI Processing steps of the SISCOM workflow, it can be 

reviewed using the multiplanar sections and 3D viewer on the Review workflow panel. SISCOM Images can also be exported to the Analyze 

workspace. To examine the SISCOM volume, do the following: 

By default, the first 12 axial SISCOM images are shown in a 4x3 arrangement. To change to a more relevant set of images that demonstrate 

focal hyper- or hypoperfusion, change the Start Slice slider to image number 170 [23]. If desired adjust the contrast/brightness of the fused 

image, select any of the Max/Min tool in the lower right-hand corner [24] and move the mouse with the left button held down to change the 

image display. This new W/L setting will be applied to all displayed images.

Review

Note the statistics for all of 

the Hyper and Hypo regions 

are reported in the Region 

Volume area. [25]

Click the Export Fused [26] 

button to save the SISCOM 

images to the workspace.

This concludes the SISCOM 

tutorial and the SISCOM 

User’s Guide. If you have 

any questions please email 

the Analyze support team at 

support@analyzedirect.com 

or call +1 (913) 338 2527.


